Installation, Start-Up and Service Instructions

Part Numbers 33CNWIRMOD, 33CNSNGMOD, 33CNOAANT1

Two wireless transceiver kits are available from Carrier. The 33CNWIRMOD kit contains the following: 2 wireless transceivers, 2 power supplies, 2 RS-232 to RS-485 converters, 2 RS-232 cables, Carrier Wireless Transceiver Configuration Manager, 2 antennas, and a loopback connector.

The 33CNSNGMOD kit contains the following: wireless transceiver, power supply, RS-232 to RS-485 converter, RS-232 cable, and an antenna.

In order to communicate outdoors between structures, an additional outdoor antenna (part number 33CNOAANT1) is required for each wireless transceiver.

Frequency Hopping — The Carrier wireless transceivers use Frequency Hopping Spread Spectrum (FHSS) technology to ensure secure, reliable long-range data transmissions. Frequency Hopping Spread Spectrum technology was developed by the U.S. military to prevent interference or interception of radio transmissions on the battlefield.

Frequency hopping devices concentrate their full power into a very narrow signal and randomly hop from one frequency to another within that spectrum up to 200 times per second. If they encounter interference on a particular frequency, the devices retain the affected data, randomly hop to another point on the spectrum, and continue transmission. There are always spaces without interference somewhere in the allotted radio spectrum. A frequency hopping device will find those spaces and complete a transmission where other wireless technologies fail.

Carrier wireless transceivers use demand-based frequency hopping where RF (Radio Frequency) is only transmitted when there is data available to transmit. The initiating transceiver is termed the master and the receiving transceiver is called the slave. Any device (host or remote transceiver) can be a master or a slave depending on which device initiates the data transfer.

Transmit Power Control — Wireless devices in close proximity often experience desensing or overloading. Carrier Wireless Transceivers minimize this problem by providing adjustments in the Power Level Feedback Control Loop based on the time-averaged Received Signal Strength Indicator (RSSI) values and the Actual Power Level Setting as shared between both devices during a communication session.

Security — Frequency hopping is inherently more secure than other RF technologies. In addition, each transceiver has a Carrier ID set in the firmware shipped straight from the factory. As the user configures each transceiver, additional network ID numbers may be provided and varying hop tables for independent networks may be assigned. The combination of firmware, software IDs, and frequency hopping technology ensures safe and secure data transmissions. Carrier wireless transceivers also support your data encryption software.
PREINSTALLATION

Every installer should perform site evaluation prior to installing the transceivers. In order to perform this evaluation the following minimum equipment must be purchased from Carrier. The two modem starter kit (33CNWIRMOD) is required to begin performing a site evaluation. The following components are in the two modem kit:

2 — standalone transceivers
2 — high gain omni-directional antenna
2 — transceiver power supplies
2 — RS-232 to RS-485 converters
2 — 9-pin RS-232 cables
1 — copy of transceiver configuration software
1 — loopback connector

If the set up requires outdoor antennas they can be purchased from Carrier as part number 33CNOAANT1.

High gain directional antennas may be required to establish reliable communications. Directional antennas can be purchased directly from the antenna vendors described in the antenna selection and location section of this manual.

Site Evaluation Testing — Loopback Test — In order to perform a loopback test the transceivers must be configured Broadcast Remote-to-All. See the Remote-to-All configuration section of this manual.

To perform a loopback test it is necessary to connect each modem (one host and one remote) to its power supply. Then connect a PC with the Configuration Manager software to a modem using the 9-pin RS-232 cable provided. Lastly, connect the second modem directly to the loopback connector. See Fig. 1.

Perform the loopback test by executing the following steps:
1. Position the modems directly on top of each other and remove both modem antennas if connected. Use a host and remote pair for this test.
2. Run the Configuration Manager on the computer and log into the software using the username “oem” and password “oem”.
3. Select the Loopback Test program tab within the Configuration Manager software.
4. In the Test String dialog box enter a text string such as TESTING.
5. Using the pointer place a check in the Instantaneous RSSI option.
6. Press the Start button on the screen to begin sending the Test String.
7. The TX pane should start displaying the Test String at regular intervals. If the string is being received and sent back by the remote transceiver the RX pane should display the same text screen. If the Test String is successfully transmitted through the loopback connector with the transceivers on top of each other proceed to Step 10.
8. If the RX pane displays "Timeout" each time the Test String is sent then perform the following tests or the sync light will not remain on:
   a. Verify that both antennas are properly installed on the transceivers.
   b. Reposition the transceivers such that the green signal strength bar is as long as possible. Normally signal strengths above .5 are required for reliable communications (see Antenna Selection and Location section).
   c. Attempt to utilize directional antennas in order to obtain reliable communications (see Antenna Selection and Location section).

INSTALLATION

Hardware Installation — Prior to installing the transceiver(s), count and check all of the delivered equipment. A power supply and an antenna is required for each transceiver. The transceiver will be attached to either RS-232, RS-485 converter to a PC or laptop. Prior to installation on the desired device, all transceivers must first be connected to and configured with a PC.

Carrier recommends mounting wireless transceivers inside a building structure. Refer to Table 1 for temperature and humidity criteria when mounting transceivers. If an antenna is mounted outdoors or the CCN network extends outside of a building, use of an RS-485 surge suppressor is recommended. Refer to CCN installation and Start-up Instructions for lightning/surge protection recommendations.

To install the transceiver, perform the following procedure and refer to Table 1 for hardware specifications:
1. Insert the power supply male connector into the corresponding female connector slot on transceiver chassis.
2. Insert power supply plug into power (i.e., power outlet). Verify LEDs 1 and 2 on front panel blink three times. LED 1 should remain lit.
3. Attach the antenna to the transceiver.
   NOTE: The antenna connection is a reverse thread SMA connection. It must be turned counterclockwise to attach.
4. Attach the male connector on the RS-232 cable to the matching serial port on the rear panel of the transceiver.
5. Connect the other end of the RS-232 cable to the matching serial port on the device.

Fig. 1 — Loopback Configuration
Table 1 — Hardware Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>2.400-2.4835 GHz license-free ISM band in U.S. (varies in other countries where transceivers have been certified)</td>
</tr>
<tr>
<td>Radio Type</td>
<td>Frequency Hopping Spread Spectrum</td>
</tr>
<tr>
<td>Number of Channels</td>
<td>417 independent, non-interfering frequencies</td>
</tr>
<tr>
<td>Data Rate</td>
<td>600 bps to 9.6 kbps full duplex</td>
</tr>
<tr>
<td>Transmit Power Output</td>
<td>10mW to 500mW nominal, self-adjusting (lower maximum power output where required)</td>
</tr>
<tr>
<td>Indoor Range</td>
<td>Up to 1,500 feet (457 m) in normal construction</td>
</tr>
<tr>
<td>Outdoor Range</td>
<td>Up to 2 miles (3.2 km) with omni-directional antenna. Up to 12 miles (19.3 km) with optional directional antenna (line of sight to the horizon)</td>
</tr>
<tr>
<td>Protocol</td>
<td>CSMA (Carrier Sense Multiple Access)</td>
</tr>
<tr>
<td>Flow Control</td>
<td>Supports Hardware, Software or None</td>
</tr>
<tr>
<td>Error Detection &amp; Correction</td>
<td>CRC 16 error detection; forward error correction can correct errors in 1 out of every 4 bits transmitted</td>
</tr>
<tr>
<td>Certification</td>
<td>FCC Part 15 Certified, Industry Canada, Japan, Europe, Brazil. Other International certifications pending</td>
</tr>
<tr>
<td>Electrical Interface</td>
<td>RS-232C Voltage Levels</td>
</tr>
<tr>
<td>Physical Interface</td>
<td>Standard RS-232C DB-9 (female) connector</td>
</tr>
<tr>
<td>Input Power</td>
<td>Shipped with a 115VAC power adapter providing: Voltage: &gt; 6.5 V and &lt; 9.0 V Ripple: Less than 250mV (RMS) from DC to 1MHz</td>
</tr>
<tr>
<td>Input Current Draw</td>
<td>Idle: 200mA Transmit: 550mA instantaneous current Transmit/Receive (time averaged over 100msec): 360mA</td>
</tr>
<tr>
<td>Environmental Temperature Range</td>
<td>–4 F to +140 F, –20 C to +60 C</td>
</tr>
<tr>
<td>Humidity</td>
<td>0% to 95% (non-condensing)</td>
</tr>
<tr>
<td>Physical Dimensions</td>
<td>1.2 inches height (30mm) x 3.8 inches width (97mm) x 5.2 inches length (132mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>6 ounces (170 grams)</td>
</tr>
</tbody>
</table>

Serial Communications — In order to configure any transceiver, a 9-pin RS-232 cable must be used. This is necessary because Pin 4 is used to transmit the configuration data into EEPROM and other pins are used during the configuration process as well (see Table 2). A 9-pin RS-232 cable is included with all stand-alone transceivers.

The 9-wire cable must be used in the following cases:
- when using the Configuration Manager to initialize/setup a transceiver
- when a Carrier CCN Interface is connected via the RS-232 port
- when field upgrading the transceiver software

Software Installation

The software has the following requirements:
- Windows® 95/98 or above (depending on software used)
- Pentium processor 233 MHz or higher
- 1 available RS-232 serial port
- Minimum 32 MB DRAM
- Maximum 20 MB hard disk space for Configuration Manager

CONFIGURATION MANAGER — The Configuration Manager program is used to configure all transceivers.

To install the Configuration Manager software, perform the following procedure:
1. Make sure all Windows applications are closed.
2. Insert the Installation CD-ROM into the appropriate drive. Select folder “CONFIG_111300” then select “Disk 1”.
3. Open the contents of the drive using Windows Explorer or My Computer.
   NOTE: Take note of all warnings and notes that refer to computer/software requirements when running this program.
4. Double-click on “Setup.exe”.
5. Follow the on-screen instructions.

Antenna Selection and Location — Several factors effect signal strength:
1. Location
   a. Line of sight between antennas is always preferred.
   b. Locations directly adjacent to walls or other structures should be avoided for omni-directional antennas.
   c. Barriers between antennas should always be considered (see barrier information on page 16 for degree of penetration).
   d. Antennas should be moved within the desired space to determine if a better location within the desired area can be found.
2. Polarization
   a. Antennas must be oriented in the same plane. For example, omni-directional stick antennas must both be vertical in the same plane in order for reliable signal reception.
   b. Directional antennas must be oriented in the same plane utilizing the vertical pole identification on the antenna.
3. Omni-directional vs. Directional
   a. Omni-directional antennas provide essentially equal signal strength around the antenna.
   b. Omni-directional antennas can receive a signal coming from virtually any direction in relation to the antenna as long as polarization is not a factor.
   c. Directional antennas provide greater signal strength in the direction that the antenna is oriented.
   d. Directional antennas are labeled with a vertical pole for proper orientation with both omni-directional and directional antennas.
   e. Directional antennas should be pointed in the direction of the receiving antenna.
   f. Directional antennas will not receive any signals coming from behind the antenna.
   g. Directional antennas should be rotated to determine if bouncing the wireless signal can be utilized in order to achieve wireless communications.
   h. For best results it is recommended that a directional antenna be used in conjunction with an omni-directional antenna. With this setup signal strength is improved while antenna lineup is fairly straightforward.
Table 2 — Stand-Alone Transceiver Pin Out

<table>
<thead>
<tr>
<th>PIN</th>
<th>NAME</th>
<th>I/O</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DCD — Data Carrier Detect</td>
<td>Output</td>
<td>Session Status (True)</td>
</tr>
<tr>
<td>2</td>
<td>TxD — Transmit Data</td>
<td>Output</td>
<td>Data from transceiver to the attached device</td>
</tr>
<tr>
<td>3</td>
<td>RxD — Receive Data</td>
<td>Input</td>
<td>Data into transceiver from the attached device</td>
</tr>
<tr>
<td>4</td>
<td>DTR — Data Terminal Ready</td>
<td>Input</td>
<td>Data/Command Mode</td>
</tr>
<tr>
<td>5</td>
<td>Gnd</td>
<td>—</td>
<td>Signal Ground</td>
</tr>
<tr>
<td>6</td>
<td>DSR — Data Set Ready</td>
<td>Output</td>
<td>Always Asserted (High)</td>
</tr>
<tr>
<td>7</td>
<td>RTS — Request to Send</td>
<td>Input</td>
<td>HW Flow Control (internally pulled up)</td>
</tr>
<tr>
<td>8</td>
<td>CTS — Clear to Send</td>
<td>Output</td>
<td>HW Flow Control (default: asserted/High)</td>
</tr>
<tr>
<td>9</td>
<td>RI — Ring Indicate</td>
<td>Output</td>
<td>Status Change (default: de-asserted/Low)</td>
</tr>
</tbody>
</table>

Antenna Installation — Antennas must be connected to each transceiver for proper operation. Without an antenna, two units will not communicate. The higher the gain of the antenna, the longer the range of the transceiver signal. All Carrier transceivers ship with a 5 db omni-directional 9-in. antenna. An outdoor antenna is also available from Carrier.

Carrier transceivers are designed to be used only with certain antenna products. Other higher gain directional antennas may be purchased through an approved Carrier supplier. Contact Carrier for additional information.

Installation onto a CCN Bus — Use the RS-232 to RS-485 converter to install transceivers directly onto an RS-485 network. An RS-232 to RS-485 converter and power supply is supplied with each transceiver.

1. Separate the RS-485 converter’s housing with a flat blade screw driver.
2. Install jumpers in all 5 terminals.
3. Wire the CCN (+) to screw terminal Pin 1, and CCN (-) to screw terminal Pin 2. See Fig. 2.
4. Cut the power plug off of the power cube 6 in. from the end.
5. Wire the ground wire of the power supply wire to screw terminal Pin 5 and the positive (wire with white line) to screw terminal Pin 6. See Fig 2.

If a transceiver is used to connect directly to a computer, an RS-232 to RS-485 converter is not required. Only the 9-pin cable (supplied) is used.

Network Topology

The Carrier transceivers support the Broadcast Network topology. Each transceiver can be configured via its Configuration Manager to work this topology. The transceiver’s Configuration Manager controls how the transceiver transmits and receives data as connected to the device. (See Fig. 3-5.)

**CAUTION**

Wireless communication signals can be adversely affected by physical and/or electrical interference. Carrier wireless transceivers should **NOT** be installed in applications where temporary loss of communications cannot be tolerated by the control system. Suitable applications include equipment monitoring, alarm monitoring, control overrides and temporary service connections.

Networks — Wireless data connectivity applications require a wide range of networking options. The network topologies consist of more than two transceivers and may have a PC to host a network of devices. The PC or network devices are each physically attached to a transceiver.

WIRELESS SERVICE TOOL — The wireless Service Tool setup allows a CCN service technician to install, commission, and troubleshoot from any location in the building. All CCN elements on the primary bus are accessible. The wireless connection allows the technician to utilize a laptop computer to perform all Service Tool functions from anywhere within the range of wireless communication. If the transceiver is located on a rooftop, it is possible to gain wireless access to the building from several miles away.

**NOTE:** Wireless buss extensions on CCN systems with secondary buses are recommended for temporary use only. Permanent use is **NOT** recommended.

WIRELESS BUS EXTENSION — The wireless bus extension setup allows a bus to be extended to a remote location through the use of the wireless transceivers. This set up can be used to connect two portions of a CCN bus when physical wiring cannot be used or is not cost effective. This set up may also be used to connect controllers in two different buildings by placing the transceiver on the roofs of the buildings. This set up is not recommended for CCN systems that contain secondary buses.

![Diagram of Converter Detail](image)
Fig. 3 — Wireless Multiple Bus Extensions of Primary Bus

Fig. 4 — Wireless Workstation

Fig. 5 — Wireless Bus Extension of Primary Bus
Wireless links can only be used to extend a CCN primary bus (bus D). Do not use bridges when using a wireless link. Utilizing this primary bus wireless connection to access CCN devices through a bridge will cause communication messages to be generated on the primary bus.

The wireless bus extension setup allows primary bus to be extended to a remote location through the use of wireless technology. This set up can be used to connect two portions of a CCN primary bus when utilizing physical wire may be a costly or difficult task. This set up may be used to connected controllers within a building or to another building by placing the modems on the roofs of the structures.

A wireless bus extension on a CCN primary bus is only recommended if there are no CCN secondary busses. If CCN bridges are installed a wireless extension of the primary bus is not recommended.

**Broadcast Network** — In a Broadcast Network, data is sent out by one transceiver (sending transceiver) and received by an unlimited number of remote devices simultaneously. These devices must be intelligent enough to recognize relevant messages and recover lost or corrupted data. Broadcast Networks operate solely as configured by the Configuration Manager.

Transmissions sent by the sending transceiver can be received by every remote unit in its associated network. Transmissions by remote units can be received by every other unit in the network that is within range. Broadcast mode is especially useful to applications where you must transfer the same information to all units at once. (See Fig. 3.)

Broadcast mode is intended primarily to be a RS-485 network wire replacement. It is especially useful in adding new equipment to systems where there is a RS-485 connection. The RS-232 to RS-485 converter is needed to configure transceivers for RS-485 devices.

An example of the broadcast set up would be a wireless bus extension to multiple buildings. The wireless bus extension set up allows any primary bus to be extended to a remote location.

### Typical Set up (Quick Start)

The following set up will guide the user through the steps of the set up, configuration, and test for Network wireless operation. These procedures assume that the locations have adequate power, peripherals, and host devices.

**Quick Configuration** — This is the fastest and easiest way to configure a unit. Activation of Quick Configuration loads settings directly into EEPROM. These settings will remain in effect until a unit is reconfigured.

1. Click Quick Configuration on the General tab. Click the Down Arrow on the toolbar or select it from the Commands menu. The Quick Configuration wizard appears with the Operating Mode window displayed.
2. Select the desired Operating Mode.
3. Select Broadcast Mode, Singlecast, Host for a network configuration of 2 or more transceivers on a Broadcast Network. When configuring slave modems, configure a remote to talk to all remotes on the network. If host is configured first, the wizard will provide options for configuring remotes. See Broadcast Network for a more detailed explanation of Broadcast modes.

**IMPORTANT:** All other selections are NOT applicable to Carrier CCN set ups.

4. Click OK.

The Unit Settings screen appears.

**Broadcast Remote-to-All** — Materials/equipment needed:
- 1 Host PC
- 2 or more transceivers
- 2 or more antennas
- 2 or more power sources (outlet and/or surge strips) and 2 or more power supplies for transceivers
- Configuration Manager software
- (2 or more) RS232 cables

Use the following procedure to install software and configure transceiver.

1. Install software.
   a. Power up Host PC.
   b. Insert the Configuration Manager software into the appropriate drive.
   c. View the contents of the drive (using Windows Explorer, My Computer etc.).
   d. Double-click Setup.exe.
   e. Follow the on screen instructions to complete the installation.
2. Connect the transceiver.
   a. Attach the power supply to transceiver 1.
   b. Plug the power supply into power source.
   c. Verify that LED 1 on the front panel of the transceiver blinks 3 times and remains lit.
   d. Attach an antenna to transceiver no. 1.
   e. Insert the RS-232 cable connector into the serial connector in the back of the transceiver.
   f. Attach the other end of this cable into the serial port on the back of the Host PC.
3. Configure transceiver no. 1.
   b. The Main window appears.
   c. Click Quick Configuration.
   d. Click on Broadcast Mode, Singlecast, Host.
   e. Enter the information as shown in the dialog box below. See Fig. 6.
   f. Click Submit.
4. Generate a report (if desired).
   a. Click Report Generation.
   b. Click Close.
   c. Click Yes to Configure Remote Units for Host.
5. Connect and configure transceivers.
   a. Click Singlecast (Remote → All).
   b. Disconnect serial connector from transceiver no. 1. (You can leave it connected to the computer.)
   c. Attach power supply to transceiver no. 2.
   d. Plug power supply into power source.
   e. Verify that LED 1 on the front panel of the transceiver blinks three times and remains lit.
   f. Attach an antenna to transceiver no. 2.
   g. Insert the RS-232 connector into the serial connector in the back of the transceiver.
   h. Insert the RS-232 connector into the serial connector in the back of the transceiver. See Fig. 7.
   i. Click OK.
   j. Click Submit.
ADVANCED CONFIGURATION

The Configuration Manager is used to configure all transceivers being used in the network. The procedures in this section describe how to configure the transceiver to meet your specific needs. This section should be used in conjunction with the Typical Set Ups (Quick Start) section. See Fig. 8.

To open your Configuration Management application:
1. From the Start menu in Windows, select Programs and then Configuration Manager.
2. A splash screen appears with a Login dialog on top requesting username and password.
3. Enter the username: “oem”
4. Enter the password: “oem”
NOTE: “oem” is lower case.
5. Click OK. The Main Window appears. A Tip of The Day window also appears. A new tip of the day will appear each time you open the configuration program. You can turn this off by unchecking the box. Click OK to dismiss the window.

Getting Status — Status lights on the Status bar indicate the status of the control lines on the RS-232 link between the PC and the transceiver being configured. See Fig. 9 and Table 3.

In addition to the status lights in the Configuration Manager, the LED’s on the stand-alone transceiver also display status. See Fig. 10.

Exiting the Program — In order to exit the Configuration Manager, refer to the following.
Select Exit from the File menu.
NOTE: It is important to note that any changes in any tab not stored in EEPROM will be lost.

Table 3 — Status Definitions

<table>
<thead>
<tr>
<th>ABBREVIATION</th>
<th>NAME</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>RI</td>
<td>Ring Indicator</td>
<td>A signal is coming into the host unit from the transceiver at the remote unit.</td>
</tr>
<tr>
<td>DCD</td>
<td>Data Carrier Detect</td>
<td>A connection has been established with another unit. This lets the PC know that communication between two units can take place.</td>
</tr>
<tr>
<td>DTR</td>
<td>Data Terminal Ready</td>
<td>Indicates that the unit is in Command Mode. This mode is utilized by the network software.</td>
</tr>
<tr>
<td>RTS</td>
<td>Ready To Send</td>
<td>This is a hardware flow control indicator</td>
</tr>
<tr>
<td>CTS</td>
<td>Clear To Send</td>
<td>A hardware control indicator</td>
</tr>
<tr>
<td>DSR</td>
<td>Data Set Ready</td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>

Fig. 6 — Singlecast (Host) Set Up

Fig. 7 — Transceiver 2 Configuration

7. Test Operation.
Connect transceiver no. 1 to the host PC. Connect transceiver no. 2 to the loopback connector. Ensure all transceivers have power and have antennas properly connected. Run the loopback test in the Unit Testing section of this manual. Repeat with the host and each remote unit.

k. Repeat as necessary for more transceivers.
l. Check Report Generation.
m. Click Close.
n. Click Cancel.
o. Select Exit from the file menu.
6. View the report.
a. Open Windows Explorer.
b. Once in Windows Explorer, Open the following file: C:\Program Files\Configuration Manager\RReport.txt.
Modifying Settings — You can run the Quick Configuration wizard to modify settings or you can change entries manually in the fields in the modification tabs provided. When manually changing entries, you must click apply and/or store for the changes to take effect. (See Fig. 11.)

1. Click the desired tab.
2. Click in and highlight the data to be changed.
3. Change the data.
4. Click Apply and Store to save changes.

Applying and Storing Changes — The following features can be selected from the Commands menu or you can click the appropriate button on the toolbar. These features write the information entered into temporary or permanent storage. See Fig. 12.

Note: Settings must be applied before they can be stored.

Apply — This applies (transfers) changes from the all tabs into the attached transceiver’s RAM (temporary memory). This is useful when changing and testing settings you are not sure you really want.

Note: When you exit the configuration program these changes will not remain in effect. You must click Store for them to become permanent.

Store Applied Settings — Stores all Applied changes into the transceiver’s EEPROM. These settings will remain in effect upon exiting the program. Stored changes are overwritten when new stored entries are made or when you load the default factory settings. You must Apply settings prior to storing them.

Reset Unit — Performs a soft reset of the attached unit returning the settings stored in EEPROM. Any configuration settings Applied but not Stored to EEPROM will be lost.

Load Default Settings — Reloads Factory Default settings into unit. All changes made previously will be lost.

Refresh — This queries a transceiver about its current settings. These settings will be displayed on the screen. It lets you go back to the last Stored settings before Apply was selected. Settings will not be refreshed if Store has been selected.
Generating Reports — Reports can be generated during the Quick Configure (if the box was checked) or can be generated at any time using menu commands. Two types of reports can be generated. Information in each report can be cleared separately. Both reports generate text (.txt) files. The default location for reports is C:\Program Files\Configuration Program. The RReport.txt file produces a formatted text file which can be viewed using any text reader or word processing program, for example, Microsoft Word®. The DReport.txt produces a comma delimited ASCII report which can be viewed with any spreadsheet program, for example Microsoft Excel®. It can also be imported into a database program like Microsoft Access®.

1. Add to an existing report.
   a. Select Add To Report from the File menu. The configuration data profile for the attached transceiver is added to the report in the location specified under the Report Settings command.

2. To change report settings.
   a. Select Report Settings from the File menu. A dialog appears showing the settings and location for storage of configuration data profiles.
   b. Select the type of report desired or both. See Fig. 13.

   Both files generated are ASCII files readable by any text reader. A readable report is formatted in ASCII with spaces and tabs to make it readable when opened in programs such as Notepad. Comma delimited formatting is useful when you want to import the text into spreadsheet or database programs. Clear the contents of a report by clicking Clear Report. If you wish reports to be generated when you run Quick Configuration, the Report generation box must be checked. Click OK.

3. To View reports in ASCII format.
   a. Select Report Settings from the File menu.
   b. Locate the path to the desired report. You can close this window and the Configuration Manager if desired.
   c. Using a text reader such as Notepad or a word processor, open the file.

4. Example: To import reports into Microsoft Excel:
   a. Select Report Settings from the File menu.
   b. Check Tab Delimited.
   c. Open Microsoft Excel.
   d. Select Import From the File menu. The Text Import wizard appears.
   e. Import the DReport.txt file.
   f. Click Comma and Tab in the Delimiters box.
   g. Click Next and fill out the rest of the wizard as desired. Each comma in the delimited file will be transformed into a column in the Excel spreadsheet.

Serial Settings

NOTE: This unit is factory set for Carrier CCN use. Do not change the unit Serial Settings.

Power Management — Power management features are preset for the Carrier CCN application and do not need to be altered. See Fig. 14 to view power modes.

Passwords and Access

LEVELS OF ACCESS — There are two levels of access: OEM and USER. Each level has access to different sets of fields in the Configuration Manager. A User has the lowest level of access and is only able to change parameters in some of the fields available to OEMs. OEMs have access to all functions. See Table 4.

All transceivers are shipped with OEM access. It is up to the administrator to assign user privileges from that point on.

PASSWORDS — Change the password as frequently as you desire. A password consists of any combination of numbers or letters up to 29 characters. Contact Carrier if a new password file is needed. All units are shipped with "oem" as the password. It is recommended for security reasons to change your password from the factory setting.

Depending on access level, you have User or OEM privileges. The dialogs that appear and the options available vary by privilege.

NOTE: All units are delivered with OEM privileges.
USER FUNCTIONS — To change the password as a user:
1. Select Change Password from the File menu. Change password dialog appears. See Fig. 15.
2. Enter the desired criteria.
   Enter user name and new password. Retype the new password in Confirm Password.
3. Click OK.

OEM FUNCTIONS — All units are delivered with default OEM privileges. The system administrator must set units to User access.

To access OEM privileges:
1. Select Change Password from the File menu. See Fig. 16.
2. Change password dialog appears.
3. Select the desired User name from the list.
4. Change user permissions as desired.

<table>
<thead>
<tr>
<th>Table 4 — Privilege Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRIVILEGE</td>
</tr>
<tr>
<td>User privileges</td>
</tr>
<tr>
<td>New</td>
</tr>
<tr>
<td>Change password</td>
</tr>
<tr>
<td>Remove users</td>
</tr>
</tbody>
</table>

Using Hop Tables — A Hop Table is a listing of frequencies in a given spectrum that are used for communication. Data is sent to each frequency in the table in a hopping pattern. Hop Tables provide improved security and the ability to avoid localized noise sources. There are 101 possible Hop Tables in your transceiver (this number may vary for international transceiver models). These are subdivided into five completely independent, non-overlapping Hop Table sets, each with no more than three consecutive frequencies. Each individual network can only utilize one Hop Table.

ENTERING HOP TABLE NUMBERS — Hop Table numbers can only be entered or changed by using the Quick Configuration wizard.

Enter the desired identification numbers. See Assigning IDs section for acceptable parameters. Select a Hop Table (0 to 100). The Hop Table selected must be the same for all transceivers in a Point-To-Point or a Network. This number specifies a table of predefined frequencies, which the transceiver will use for transmitting and receiving. If multiple separate networks exist in the same area, each network should have a unique Hop Table number to avoid RF collisions. Depending on which network is selected in the previous screen, certain ID fields may be grayed and inaccessible.

If multiple isolated wireless networks are installed in the same area, it is recommended that hop tables 1-5 be used sequentially.

VALIDATING THE HOP TABLE — This command verifies the integrity of the Hop Table stored within the transceiver. The Hop Table in the transceiver is compared to the Hop Table with the same number in the Configuration Manager database. The Advanced Settings tab provides the selected Hop Table number and whether the Hop Table has passed validation and the first and last indices used for the Hop Table. Index values are set to meet the requirements of the country in which the transceiver is deployed for a minimum number of hop frequencies. These values can not be changed to avoid violating country regulations. To validate the Hop Table, from the Commands menu, select Validate Hop Table.

SPECIFYING HOPPING PARAMETERS — You can customize Hop Table parameters by setting some features available from the Advanced Settings tab.

Max No Data — (Adjustment of these settings is not recommended.)

Max No Data is the number of hop cycles that must pass during which no data was received and no data was available for transmission before a session can be declared down. It is used as the trigger to end a session. After a certain number of Frames No Data between both units, the master will terminate the current session/link.

Max Bad Hop — (Adjustment of these settings is not recommended.)

Max Bad Hop is the number of data frames with errors received before a link is considered bad. This is the trigger to stop the current link and wait for a random standoff period (approx. 0.5 to 3 seconds). This is due to the assumption that after 4 consecutive bad hops (system default but can be changed), the link has been lost — either due to interference or lost synchronization. By waiting a small amount of time before attempting to reestablish the link, the obstruction (i.e., noise source) may have moved somewhere else.
Session Holdoff — (Adjustment of these settings is not recommended.)

This will only be enabled for a host transceiver and is required to manage the communication from multiple remotes. It prevents a host unit from starting a new session until it completes its current session. It keeps other devices from establishing a session with the host until the host has completed its current session with a particular device.

Assigning IDs — Using a combination of firmware and software assigned IDs, the security of the data is ensured. Some IDs can be modified and others cannot depending on your privileges. The IDs are all accessed either via Quick Configuration or the General Tab. See Fig. 16 and Table 5.

<table>
<thead>
<tr>
<th>Table 5 — ID Types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID TYPE</strong></td>
</tr>
<tr>
<td>Vendor ID</td>
</tr>
<tr>
<td>Network ID</td>
</tr>
<tr>
<td>Source Unit ID</td>
</tr>
<tr>
<td>Destination Unit ID</td>
</tr>
<tr>
<td>Alias Source Name</td>
</tr>
<tr>
<td>Alias Network Name</td>
</tr>
</tbody>
</table>

Signal Analysis — There are a number of features which can help you analyze the strength and consistency of your data signal. They are available via the Advanced Settings tab. See Table 6.

<table>
<thead>
<tr>
<th>Table 6 — Advanced Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FEATURE</strong></td>
</tr>
<tr>
<td>TX Power</td>
</tr>
<tr>
<td>Power Ctrl Upper Value</td>
</tr>
<tr>
<td>Power Ctrl Lower Value</td>
</tr>
<tr>
<td>Temperature</td>
</tr>
<tr>
<td>Local time-averaged RSSI</td>
</tr>
<tr>
<td>Local instantaneous RSSI</td>
</tr>
<tr>
<td>D/A / A/D Loopback</td>
</tr>
</tbody>
</table>

Unit Testing — You can test the operation of transceivers in a variety of ways using the Configuration Manager. The instructions in this section assume that the Configuration Manager is correctly installed and the transceiver is properly connected to your PC.

The test string is transmitted to the Destination Unit and looped back to the Source Unit. The RX Pane shows the test string as received by the transceiver connected to the computer after being loopbacked from the remote transceiver. If no data is received within the timeout period the message “Timeout” is printed in the RX Pane. The TX Pane shows the test string as typed in the dialogue box.

To perform a communication link test it will be necessary to use two Carrier wireless transceivers, two antennas, a loopback connector and a computer.

Perform the following tests:
- Terminal mode
- Loopback test (Stand-alone model only)

TERMINAL MODE TEST — The Terminal Mode tab provides a simple terminal interface from which data can be sent between two units configured as a Broadcast Remote-to-All Host and Remote Pair. Anything typed in the input field of transceiver no. 1 will immediately be transferred to transceiver no. 2. The data is displayed in the transmit pane for transceiver no. 1 and the receive pane for transceiver no. 2. (NOTE: You will only see received data if the destination transceiver is connected to a PC with Configuration loaded and open or if the destination PC’s transceiver has a loopback connector.)

What You Need:
- Two transceivers (A and B) configured as a host to remote. The Source Unit ID of unit A equals the Destination Unit ID of unit B and vice-versa. In addition, both units must have matching Vendor ID numbers, Network ID numbers and Hop Table numbers.
- One of these units is connected to a PC with the Configuration Manager loaded.
Test Communications Between Units:
1. Open the Configuration Manager. See Fig. 17.
2. Click the Terminal Mode tab.
3. In Test String, enter some text.
4. Click Resend.

The test string is transmitted to the Destination Unit.

LOOPBACK TEST — The Loopback Test screen allows you to perform two functions; to test that two units can communicate and to determine the best placement of one unit relative to another based on received signal strength. This test is only used for stand-alone models.

What You Need:
• Two transceivers (A and B): configured as a Broadcast Remote-to-All and Host Pair. The Source Unit ID of unit A equals the Destination Unit ID of unit B and vice versa. In addition, both units must have matching Vendor ID numbers, Network ID numbers and Hop Table numbers. Transceiver A is connected to a PC loaded with the Configuration Manager.

NOTE: Test also works with host/remote set up.
• Loopback connector: Transceiver B (the one not connected to the PC running this program) must have a loopback connector (pins 2 and 3 of the serial port tied together) on the serial port of the remote unit. A loopback connector is delivered with all demo and developer kits.

NOTE: Connect loopback connector to remote units if using a host to remote set up.

Test Communications Between Units:
1. Open the Configuration Program. See Fig. 18.
2. Click the Loopback Test tab.
3. In Test String, enter some text.
4. Enter the desired criteria in other fields in this group. The default values are recommended for this type of testing. The minimum for Repeat Every field is 100 msec.
5. Click Start.

Test the Placement of a Unit:
1. Click the Loopback Test tab. See Fig. 19.
2. Click Test.
3. Click Instantaneous RSSI.
4. Enter some text in the Test String.
5. Enter the desired criteria in other fields in this group. The default values are recommended for this type of testing.
6. Click Start.

VIEWING DATA IN THE RX AND TX PANES — These display areas show the data being transmitted and received during tests. The RX pane shows data being received into the transceiver. The TX pane shows data being transmitted from the transceiver. All data sent will be displayed and at times the pane may become cluttered. You can use the Clear buttons on the toolbar or the commands in the Edit menu to clear the panes of data. To clear data in the panes, select Clear RX Pane or Clear TX Pane.

If the RX pane displays Timeout? each time the Test String is sent then perform the following tests:
• Verify that both antennas are properly installed on the transceivers.
• Reposition the transceivers such that the green signal strength bar is as long as possible. Normally signal strengths above .5 are required for reliable communications (see Antenna Selection and Location section).
• Attempt to utilize directional antennas in order to obtain reliable communications (see Antenna Selection and Location).
Fig. 18 — RX Configuration Window

Fig. 19 — Loopback Test Window
**Troubleshooting (See Table 7)**

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>POSSIBLE CAUSE</th>
<th>POSSIBLE SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Timeout?” messages are displayed in the Configuration Manager general tab fields.</td>
<td>The equipment is not connected properly.</td>
<td>Check that all connections are secure. Make sure transceiver has power (LED 1 is lit).</td>
</tr>
<tr>
<td>Antenna cannot be threaded onto the antenna connector.</td>
<td>Antenna and antenna connector have “left-handed” threads.</td>
<td>Turn antenna connector counterclockwise to attach to transceiver.</td>
</tr>
<tr>
<td>LED 1 not lit</td>
<td>Power is not being supplied to unit.</td>
<td>Check power supply connection into unit and outlet. Make sure supply of power is active.</td>
</tr>
<tr>
<td>LED 1 and LED 2 flash 3 times</td>
<td>Normal operation.</td>
<td>No need to troubleshoot.</td>
</tr>
<tr>
<td>Open the Configuration Manager and get an error message</td>
<td>Outdated DLL.</td>
<td>Run 401COMUPD.exe included in program disk to install COMCTL32.DLL in your C:\Windows\System directory.</td>
</tr>
</tbody>
</table>

**System Configuration** — Refer to the following to check system configuration:

- Do the power and link LEDs blink 3 times as described in the Setup section?
- Does the power indicator remain on after power up?
- Are the RS232 9-pin cables or RS485 converters attached?
- If the RS232 9-pin cable is being used, do all 9 wires in the serial cable have continuity from one end to the other?
- Are all connections secure to unit and connected device?
- Does the TX LED blink when you are sending data to the transceiver from the computer or originating device?
- Does the unit communicate with a loopback test?
- If the transceiver is a Broadcast/Remote or Point-to-Point, are the sync and power LED’s on?
- How far apart are the transceivers?
- Are they out of range?
- What antennas are you using?
- Where are they mounted?
- If there is a cable run between the transceiver and the antenna, how long?
- Have you tried to communicate with the transceiver in different locations or with different antennas?
- What are the RF barriers between the antennas? See Table 8.

**Table 8 — RF Signal Barriers**

<table>
<thead>
<tr>
<th>BARRIER</th>
<th>SEVERITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete Wall</td>
<td>High</td>
</tr>
<tr>
<td>Metal Wall</td>
<td>High</td>
</tr>
<tr>
<td>Wood Framed Wall</td>
<td>Moderate</td>
</tr>
<tr>
<td>Glass</td>
<td>Low</td>
</tr>
<tr>
<td>Trees</td>
<td>Low to High depending on type (high = Pine)</td>
</tr>
<tr>
<td>People</td>
<td>High</td>
</tr>
<tr>
<td>Vehicular Traffic</td>
<td>High</td>
</tr>
</tbody>
</table>

**Frequently Asked Questions (FAQs)**

Q: Can I use an external antenna?

A: Yes, many different versions of 2.4 GHz omni-directional or directional antennas can be used. Please contact Carrier for additional information.

Q: Can I use other, longer runs of cox than what is provided from Carrier?

A: Yes. Longer coax can be used but one should keep the length of the coax as short as possible and use low loss coax as appropriate for the length of the run.

Q: What types of coax can I use?

A: RG-316, RG-223, LMR240, 300, 400, 600 and many other types that are suitable for 2.4 GHz RF signals. It is important to choose a low loss coax and realize that the longer the coax the greater the loss. Also, remember that the Carrier transceivers have a reverse thread SMA female connectors only so your coax will need to mate with that.

Q: How great a length of coax can I use?

A: It depends on type of coax. A very low loss coax can be used at distances up to roughly 50 ft. It is critical, however, that the correct coax and connectors are used and that the coax system loss is not too great. The maximum power output of a Stand-Alone Carrier Transceiver at the reverse thread SMA connector is 500 mW.

Q: When should I use a directional antenna versus an omni-directional antenna?

A: A directional antenna is a good choice any time you have only a specific direction from which signals are sent or received. If you have a Host (master) Carrier transceiver and there are Remote Carrier transceivers in all directions from the Host you should use a directional antenna in most if not all cases. A directional antenna can extend your range by concentrating the radiated energy from the antenna in a certain direction. Also, a directional antenna will only receive signals that are in its specific angle reception. RF interference outside the antennas area will not be ‘visible’ by the antenna and in this way can increase the transceivers receive capability.

Q: The range specification with omni-directional antennas is 2 miles. Does that require line-of-sight?

A: Yes it does. If the range between antennas is short, say 1000 ft and there are no major obstructions such as earth, major metallic structures or other obstructions, chances are good that an acceptable RSSI (receive signal strength indication) will be achievable at each transceiver. The problem is, every applications environment is different and there is no way to know for sure unless one tests the units in that actual physical setting.

Q: How much does line-of-sight matter with Carrier transceivers?

A: As a general rule, line-of-sight is required to assure communications. The Carrier transceivers operate at 2.4 to 2.4835 GHz with a maximum power output of 500 mW. The transceiver’s ability to receive adequate signal levels is entirely dependent on the placement of the antennas and the distance they are from one another. There is no absolute guarantee in advance that a given installation of Carrier transceivers will yield a good communication link. However, if the range is under 1000 ft, adequate communication can be accomplished in many cases without line-of-sight as long as the proper antennas have been selected and installed as required. In general, with ranges up to and exceeding 1500 ft, line-of-sight is required.
Q: Should I incorporate lightning surge protection for my transceiver?
A: It is a good idea whenever your coaxial cable lengths are 20 feet or more. Contact your Carrier representative.

Q: What is the highest baud rate of the Carrier RS-485 adapter?
A: 9600 Baud.

Q: How many network IDS are available?
A: 64,000

Q: How can I improve communications indoors?
A: Try using directional antennas to lessen or eliminate bouncing signals being received from the remotes.

Q: Is it possible for CCN communication retries to happen because of wireless interference?
A: Yes, although Carrier wireless modems are designed to avoid communication interruption, it is possible for the user to see duplicate alarms on a ComfortWORKS® or ComfortVIEW™ display due to wireless interference.

Q: Are there limits to the application of wireless CCN communications?
A: Yes. As with any wireless communication, the transceiver can be interfered with by a physical blockage or electrical interference. Carrier wireless transceivers should NOT be installed in applications where temporary loss of communications cannot be tolerated by the control system. Suitable applications include equipment monitoring, alarm monitoring, control overrides and temporary service connections.